
Cara Mengatur Tab Stop (Tabulasi) Microsoft Word 

 

Para pengguna Ms Word mungkin ada yang belum mengetahui tentang Tab Stop atau mungkin 

sudah tahu tapi belum dapat memaksimalkan penggunaannya. Nah, Tab Stop sendiri adalah tempat atau 

jarak berhenti kursor saat menekan tombol Tab pada keyboard. Secara default, kursor akan berpindah 

tempat sejauh 0,5 inchi atau 1,27 cm setiap kali tombol Tab ditekan.  

 

Tab Stop sangat berguna untuk memformat perataan teks agar terletak pada posisi yang sama di setiap 

baris. Berikut contoh penggunaan Tab Stop secara sederhana: 

 

Nama        : Syahrul 

NIM           : 4521049 

Agama      : Islam 

 

Tanpa Tab Stop, membuat format teks seperti di atas akan membutuhkan waktu lebih lama karena 

harus menekan tombol spasi atau space bar berkali-kali untuk meratakannya.  

 

Tab Stop sendiri dibagi menjadi 5 jenis dengan fungsinya masing-masing. Sehingga dapat dipilih jenis 

yang paling cocok untuk format yang akan kita buat. Berikut rincian jenis-jenis Tabs Stop dan contoh 

penggunaannya: 

 

1. Tab Kiri: untuk pengaturan Tab Stop dengan perataan teks kiri. Perhatikan garis putus-putus 

pada gambar di bawah ini, disitu letak Tab Stop (Tab Kiri) dan teks akan dimulai dari garis 

tersebut ke arah kanan. 

https://1.bp.blogspot.com/-IgnrUREG6b8/XSn1Bl2bWLI/AAAAAAAAB-I/sDofPxlSId8wsQOctLHwjT6MucYc9kj7QCLcBGAs/s1600/sampul.PNG


 

2. Tab Tengah: untuk pengaturan Tab Stop dengan perataan teks tengah. Perhatikan garis putus-

putus, disitu Tab Stop (Tab Tengah) diletakkan dan teks menjadi rata tengah dengan patokan 

tab tersebut. (bukan berada di tengah halaman) 

 

3. Tab Kanan: untuk pengaturan Tab Stop dengan perataan teks kanan. Perhatikan letak nomor 

halaman, disitu letak Tab Stop dan teks dimulai dari garis tersebut ke arah kiri.  

 

4. Tab Desimal:  untuk mengatur Tab Stop rata kanan sebelum karakter/simbol desimal ( ,koma 

atau .titik tergantung settingan komputer masing-masing), kemudian menjadi rata kiri setelah 

desimal. 

https://1.bp.blogspot.com/-phKIKm-fmA4/XSn2WFgLNOI/AAAAAAAAB-Q/F73dRylnwzICWm6F71fGaG91VzQQPAAwgCLcBGAs/s1600/tab%2Bkiri.PNG
https://1.bp.blogspot.com/-cGoUds07V6w/XSn27dcOC_I/AAAAAAAAB-Y/fbXehClSQtwkTcjLSLYu0lJyiU6OgBhQgCLcBGAs/s1600/tab%2Btengah.PNG
https://1.bp.blogspot.com/-6-Rfy-3ljyY/XSn3oYgkblI/AAAAAAAAB-g/MPTnkDwGhbExt6YWOknV4RxEzbsctqncQCLcBGAs/s1600/tab%2Bkanan.PNG


 

5. Tab Bar: hanya untuk memberi tanda/simbol garis tegak. Garis tersebut akan dilalui oleh teks 

seakan-akan tidak ada sesuatu dan tidak berpengaruh pada jarak tombol Tab. Perhatikan gambar 

berikut: 

 

Untuk menggunakan fungsi Tab Stop ini sangat mudah, yaitu: 

1. Pertama-tama letakkan kurosr pada baris yang ingin diberi/diaktifkan fungsi Tab Stop 

2. Kemudian pilih jenis Tab Stop yang akan digunakan,  

3. Selanjutnya klik ruler pada posisi/letak yang dikehendaki, misalnya klik pada posisi 7,  

4. Terakhir, tekan tombol Tab pada keyboard untuk memindahkan posisi kursor sesuai posisi yang 

telah diatur atau ketik teks terlebih dahulu kemudian pindahkan posisinya dengan menekan Tab. 

Selain cara diatas, kita juga bisa mengatur Tab Stop secara lebih lengkap melalui jendela/kotak dialog 

Tabs, caranya sebagai berikut: 

1. Pilih Menu Home, kemudian klik ikon kecil disudut kanan bawah kelompok Menu Paragraph 

2. Kemudian akan muncul kotak dialog Paragraph, lalu klik Tabs...  

3. Maka muncul kotak dialog Tabs dan penjelesannya: 

https://1.bp.blogspot.com/-aSdOrotJFqo/XSn4GRn5vcI/AAAAAAAAB-o/jfdRaOD137MxyqC4pRLbDTsB8QtfxlKGQCLcBGAs/s1600/tab%2Bdecimal.PNG
https://1.bp.blogspot.com/-_KD1v2-wH3Y/XSn47HFGscI/AAAAAAAAB-w/ufjG2BR4oVgt2zvs5aoCERX6MprY98mYQCLcBGAs/s1600/tab%2Bbar.PNG


 

1. Tab Stop Position: untuk menentukan posisi tab stop, kita dapat menuliskan posisinya 

secara lebih pasti daripada menentukannya melalui ruler. 

2. Aligment: untuk memilih jenis Tab Stop seperti yang sudah dijelaskan diatas (Left, 

Center, Right, Decimal, dan Bar) 

3. Leader: untuk memilih jenis leader. Contoh: jenis leader nomor 2 yang sering digunakan 

untuk membuat daftar isi. 

4. Default Tab Stop: untuk mengubah default jarak perpindahan kursor ketika tombol Tab 

ditekan. 

4. Setelah menentukan pengaturan di atas, selanjutnya klik Set untuk mengaktifkannya.  

5. Klik Ok untuk mengakhiri dan lihat hasilnya. 

Untuk menghilangkan/menghapus format Tab Stop, lakukan dengan cara men-drag (klik tahan) Tab 

Stop pada ruler ke arah bawah.  

 

Itulah uraian tentang Tabs Stop, cara menggunakan serta cara mengaturnya. Semoga dapat bermanfaat 

bagi teman-teman. Jangan lupa berbagi pengetahuan 

 

Tugas 

Buatlah daftar isi makalah menggunakan tabulasi!!! 

https://1.bp.blogspot.com/-2qwxgRsdyfE/XSn5wI6x_pI/AAAAAAAAB-4/-jhNtZmBTioO3gHJFNQOMyzatmYL39WMwCLcBGAs/s1600/tabs.PNG


Cara Membuat Daftar Isi Otomatis 

Untuk cara membuat daftar isi otomatis di Word yang mudah diupdate, Anda bisa melakukannya dengan 

memilih heading styles ke text yang ingin Anda sertakan di daftar isi. Setelah itu, Word akan secara 

otomatis membangun daftar isi Anda dari berbagai heading yang ada di dokumen Anda. 

Terapkan Heading Styles 

Cara buat daftar isi otomatis pertama adalah pilih teks yang Anda ingin masukkan ke dalam daftar isi, 

kemudian di tab Home, piilh heading style, misalnya Heading 1. 

Lakukan ini untuk setiap text yang ingin Anda masukkan ke dalam daftar isi. Misalnya, jika Anda 

menulis sebuah buku, Anda bisa menggunakan Heading 1 untuk setiap judul bab di buku Anda. 

Cara Membuat Daftar Isi ke Dokumen 

Seperti yang sudah disebutkan sebelumnya, Word menggunakan heading di dokumen Anda untuk 

membangun daftar isi otomatis yang bisa di update langsung saat Anda mengubah heading text, sequence, 

atau level. 

 Klik dimana Anda ingin memasukkan daftar isi Anda 

 Klik References > Table of Contents , kemudian pilih salah satu style dari list Automatic 

Table of Contents yang tersedia. 



 



Dengan Microsoft Word, Anda juga bisa memformat atau mengkostumisasi daftar isi. Anda bisa 

mengubah font, jumlah heading level yang digunakan, dan memilih apakah Anda ingin menggunakan 

titik-titik di antara judul bab dan nomor halaman. 

Mengaktifkan hyperlinks dengan satu klik 

Di Microsoft Word, hyperlink juga dibuat yang menghubungkan judul dalam daftar isi ke judul dalam 

dokumen Anda. Untuk mengikuti link, tahan saja tombol Ctrl dan klik pada judul dalam daftar isi. 

Jika menekan Ctrl tampak seperti langkah ekstra dan merepotkan, Anda bisa membuatnya sehingga Anda 

bisa mengikuti link hanya dengan sekali klik. 

 Klik File > Options . 

 Di kotak dialog Word Options , klik Advanced . 

 Di bawah Editing options , batalkan pilihan Use CTRL + Click to follow hyperlink. 

 

Ubah atau tambahkan level dalam daftar isi 

Jika Anda ingin mengubah level entry daftar isi individu, ubah level judul teks itu di dokumen Anda. 

Untuk mengubah jumlah level yang ditampilkan dalam daftar isi Anda adalah mengganti tabel yang ada 

dengan yang berisi level yang Anda inginkan. Cara yang lebih pendek namun lebih teknis untuk 

melakukannya adalah dengan mengedit informasi field code. 

Ubah level entry judul pada Daftar Isi 

Untuk mengubah level entry dalam daftar isi Anda, cukup ubah level judul teks itu di dokumen Anda. 

 Klik judul yang ingin Anda ubah. 

 Pada tab Home , di grup Styles , klik judul yang Anda inginkan. 

 Pada tab References , klik Update Table . 

 Klik Update entire table , dan kemudian klik OK . 

Ganti daftar isi 

Klik References > Table of Contents > Custom Table of Contents 



 

Pada kotak dialog Table of Contents , dalam daftar Show levels , pilih jumlah level yang Anda inginkan, 

dan kemudian klik OK. 

 

Misalnya, jika Anda mengklik 2, maka semua teks dengan gaya Heading 1 atau gaya Heading 2 yang 

diterapkan akan ditampilkan di daftar isi. 

Bila Anda ditanya apakah ingin mengganti daftar isi yang ada, klik Yes . 

Edit informasi field code 

Word menyisipkan field secara otomatis saat Anda menggunakan perintah tertentu. Misalnya, ketika 

Anda menambahkan nomor halaman, Word memasukkan Page field. Saat Anda membuat daftar isi, Word 

memasukkan TOC field. 



Anda dapat mengedit informasi kode lapangan dengan cepat mengubah jumlah level yang ditunjukkan di 

TOC Anda. 

Klik di daftar isi Anda, lalu tekan Alt + F9. Informasi field code akan muncul di antara kurung kurawal. 

 

Ubah angka dalam tanda petik. Misalnya, jika Anda ingin hanya menampilkan dua level, ubah “1-3” 

menjadi “1-2”. 

Tekan Alt + F9 untuk menampilkan daftar isi lagi. 

Perbarui daftar isi untuk melihat perubahan Anda ( References > Update Table ). 

Format Daftar Isi 

Bila Anda ingin menambahkan daftar isi makalah, buku, maupun laporan di Word, Anda juga dapat 

menyesuaikan tampilannya. Misalnya, Anda dapat memilih berapa tingkat judul yang akan ditunjukkan 

dan apakah akan menunjukkan titik-titik di antara judul dan nomor halaman. 

Anda juga dapat mengubah format teks dari daftar isi Anda, dan format itu akan terus tersimpan tidak 

peduli berapa kali Anda memperbarui daftar isi Anda. 

Mengubah layout daftar isi Anda 

Pada tab References , pilih Table of Contents > Custom Table of Contents 

 

Buat perubahan di dialog box Table of Contents . Anda akan melihatnya di area Print Preview dan Web 

Preview. 

 Untuk menambahkan garis titik-titik di antara setiap judul dan nomor halamannya, klik Tab 

leader dan kemudian pilih garis titik-titik. Anda bisa memilih dash leader atau menghilangkan 



garis titik-titik tersebut seluruhnya dan membiarkan bagian antara judul dan nomor halaman 

tersebut kosong. 

 Untuk mengubah penampilan daftar isi Anda, klik Format , kemudian klik format yang Anda 

inginkan. 

 Untuk mengubah jumlah level yang disajikan di daftar isi Anda, klik Show levels , kemudian 

pilih nomor level yang Anda inginkan. 

Baca juga: Begini Cara Menulis Meta Description yang Mampu Menghasilkan Traffic 

 

Klik OK 

Format text di daftar isi Anda 

Yang tak boleh dilupakan ketika membahas cara buat daftar isi tentunya adalah format text. Untuk 

mengubah tampilan text di daftar isi Anda, ubah style untuk setiap level di daftar isi. 

Pada tab References dari Ribbon klik Table of Contents > Custom Table of Contents . 

Pada kotak dialog Table of Contents , klik Modify . Jika tombol Modify berwarna abu-abu, 

ubah Format menjadi From template . 

Dalam daftar Styles, klik level yang ingin Anda ubah lalu klik Modify . 

https://www.dewaweb.com/blog/begini-cara-menulis-meta-description-yang-mampu-menghasilkan-traffic/


 

Di kotak dialog Modify Style , buat perubahan format yang Anda inginkan, lalu klik OK . 

Ulangi langkah 3 dan 4 untuk semua tingkat yang ingin Anda tampilkan di daftar isi Anda. 

Mengubah dan Mengupdate Daftar Isi Anda 

Jika Anda menulis bab lain di buku Anda, Anda dapat menambahkan judul bab lain, highlight judul itu, 

dan klik Heading 1. 

Atau, misalnya, katakanlah Anda ingin mengubah judul Bab 3. Ubah saja sesuai dengan keinginan Anda. 

Setelah Anda melakukan semua perubahan ini, lihat bagian atas dokumen Anda dan temukan daftar isi 

Anda. Klik pada menu dropdown dan klik Update Table > Update all table untuk memastikan bahwa 

daftar isi Anda terupdate sesuai dengan yang Anda mau. 

Page Number di Microsoft Word 

Jika Anda ingin membuat daftar isi di Microsoft Word, page number tentunya adalah satu hal yang perlu 

ada pada dokumen Anda. Seperti yang sudah disebutkan di atas, page number atau nomor halaman 

tentunya akan membantu Anda untuk menavigasi dokumen dan memberitahu pembaca dimana mereka 

bisa menemukan informasi tertentu yang mereka butuhkan. 

Berikut adalah beberapa tips yang berhubungan dengan page number di Microsoft Word. 

Baca juga: 3 Strategi Marketing untuk Meningkatkan Trafik Web & Blog 

Menambahkan Page Number atau Nomor Halaman Pada Dokumen 

Tambahkan penomoran halaman dasar ke dokumen Word dengan menggunakan tombol Page 

Number pada tab Insert . 

 Pilih Insert > Page Number . 

 Pilih lokasi, seperti Top of Page atau Botoom of Page , lalu pilih salah satu style yang Anda 

suka di galeri. Word akan secara otomatis menambahkan page number di setiap halamannya. 

https://www.dewaweb.com/blog/3-strategi-marketing-untuk-meningkatkan-trafik-web-blog/


 Setelah selesai, pilih Close Header and Footer , atau klik dua kali di luar area header dan footer. 

Menambahkan nomor halaman di bagian header atau footer 

Jika Anda mencoba menambahkan nomor halaman ke header atau footer yang sudah memiliki text seperti 

misalnya judul bab dengan menggunakan Insert > Page Number , teks Anda yang ada akan diganti 

dengan nomor halaman. 

Gunakan Quick Parts untuk menambahkan nomor halaman ke header atau footer yang ada 

 Klik dua kali di area header (bagian atas halaman) atau area footer (bagian bawah halaman) 

untuk membuka tab Design di bawah Header & Footer Tools . 

 Di grup Position , pilih Insert Alignment Tab , dan pilih Center, Left, atau Right , tergantung 

dari mana Anda ingin nomor halaman Anda muncul, lalu klik OK. 

 Pada tab Insert , pilih kotak dialog Quick Parts > Field . 

 Dalam daftar Field Names , pilih Page , dan di bawah Field properties , pilih format penomoran 

yang ingin Anda gunakan, kemudian pilih OK. 

 Untuk kembali ke dokumen Anda, pilih Close Header and Footer . 

Tips tambahan memberi nomor halaman pada dokumen Word 

Terkadang Anda mungkin tidak ingin page number yang ada di header atau footer dokumen Anda untuk 

menjadi nomor halaman yang sesungguhnya. 

Anda mungkin tidak ingin nomor halaman Anda muncul di halaman pertama atau di title page, tetapi 

ingin agar di halaman kedua muncul tulisan “Page 2”. 

Mungkin juga halaman pertama dokumen Anda adalah judul, halaman kedua adalah daftar isi, dan karena 

itu, Anda ingin halaman yang ditandai sebagai “Page 1” dokumen Anda dimulai dari halaman ketiga. 

Anda mungkin mengerjakan sebuah set dokumen, dimana dokumen pertama dimulai dari “Page 1” dan 

berakhir di “Page 28”. Anda lalu ingin agar dokumen kedua dimulai dengan “Page 29” karena itu adalah 

kelanjutannya. 

Berikut ini adalah hal-hal yang bisa Anda lakukan untuk memenuhi ketiga skenario di atas. 

Baca juga: Rekomendasi SEO Tools Gratis Terbaik untuk Riset Keyword 

Menghilangkan nomor halaman dari halaman pertama 

 Klik tab Insert , klik Header > Edit Header (atau Footer > Edit Footer ). 

 Pada tab Header & Footer Tools Design , di group Options , pilih Different First Page . 

 

https://www.dewaweb.com/blog/seo-tools-gratis-terbaik-untuk-riset-keyword/


 Di are header atau footer, Anda akan melihat sebuah label di halaman pertama yang 

bertuliskan First Page Header . Pilih nomor halaman untuk di highlight dan kemudian tekan 

tombol Delete, atau klik kanan dan pilih Cut . 

 Klik Close Header and Footer atau tekan Esc untuk keluar. 

Mulai penomoran halaman tidak dari halaman pertama 

Untuk memulai nomor halaman di dokumen Anda, Anda bisa memisahkan dokumen Anda menjadi 

bagian, membatalkan link ke bagian tersebut, dan kemudian memasukkan nomor halaman. Anda 

kemudian memilih gaya penomoran halaman dan memilih nilai awal untuk setiap bagian. 

 Klik halaman pada dokumen yang ingin Anda jadikan halaman pertama. Ini dimana Anda akan 

memasukkan section break. 

 Klik Layout > Breaks > Next Page 

 

 Double-click pada area header atau footer di halaman yang ingin Anda jadikan halaman pertama. 

Ini akan mengeluarkan tab Design di bagian Header & Footer Tools . 

 Klik Link to Previous untuk mematikan linknya dan membatalkan link dari header atau footer 

ke bagian sebelumnya. 

 



 Klik Page Number dan kemudian pilih salah satu lokasi dan style. Sebagai contoh, klik Top of 

Page dan kemudian pilih jenis desain yang Anda sukai. 

 Klik Page Number > Format Page Numbers untuk membuka dialog box Page Number 

Format . 

 Untuk memulai penomoran halaman dengan nomor 1, klik Start At , dan ketik 1. Jika tidak, 

Word akan secara otomatis mengaplikasikan nomor halaman yang sebenarnya. 

Baca juga: 10 Bisnis untuk Mahasiswa, Tertarik Mencoba? 

 

 Klik OK 

 Untuk menghapus nomor halaman dari bagian sebelumnya, pilih nomor halaman di bagian itu 

untuk di highlight dan tekan Delete, atau klik kanan dan pilih Cut. Semua nomor halaman di 

bagian itu akan dihapus. 

 Setelah selesai, klik Close Header and Footer atau klik dua kali di luar area header atau footer. 

Memulai penomoran halaman tidak dari nomor 1 

Gunakan Page Number Format untuk memilih angka yang berbeda untuk penomoran halaman dokumen 

Anda. 

 Double-click di area header atau footer untuk membuka tab Design di bagian Header & Footer 

tools. 

 Jika Anda menambahkan page numbers untuk pertama kalinya, pilih Page Number , pilih lokasi, 

dan kemudian pilih sebuah style di gallery. 

 Klik Page Number > Format Page Numbers untuk membuka kotak dialog Page Number 

Format . 

 Di bawah Page Numbering , pilih Start at , ketik nomor yang ingin Anda mulai, lalu pilih OK. 

 Pilih Close Header and Footer atau klik dua kali di luar area header atau footer. 

 

https://www.dewaweb.com/blog/bisnis-untuk-mahasiswa/

